How to Add Date and Digital Signature Fields to
a Portable Document Format (PDF) File

Date Field

l.
2.

In Adobe Acrobat Pro DC, open the PDF.

Click the Tools tab and under Prepare Form, click Open.

3. At the screen stating: “Select a file or scan a document to begin” Adobe should already
display the file you have opened in Step 1. If you need to change the file, then click on
“Change File” and browse to the correct file.

a. Do not check the box next to: “This document requires signatures” (it changes which
signature field options are available).

b. Recommendation: Change the Form Field auto detection to OFF by clicking
“Change” and unchecking the last box in General for: “Automatically detect form
fields,” especially if the files you are adding the digital signature field to are not
forms. If you choose to keep the “Form field auto detection is ON” you may get form
fields detected in error. If this happens, click on the fields you do not need and delete
them. Do not leave fields that you do not need in the file because this will affect
accessibility and compliance with Section 508.

c. You may get a message: “No form fields detected.” This is fine, especially if the
document is correspondence or the file is not a “form.”

4. Click Start.
5. On the Prepare Form ribbon over the top of the document, click the icon for Add a date
field.
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6. Your mouse will turn into a light blue box for you to Left mouse click (and hold) > Drag
a box > Release mouse button (This is where you want the date stamp field in your
document).

United States Department of the Interior

OFFICE OF THE SECRETARY
Washington, DC 20240
0-003
; of Bureans and Offices

7. Using the leader lines Release the date field under the letterhead even and centered on
“OFFICE OF THE SECRETARY.” You will standardize the placement and size of box
you create in Step 11.

United States Department of the Interior

OFFICE OF THE SECRETARY
Washington, DC 20240

Field Name:
| Datel_af_date

QOCIO Directive 2020-003

[]Required field All Properties

To: Agsistant Secretaries
Heads of Bureaus and Offices

8. Within the Field Name properties box, enter “Date Signed” and check the box next to:
“Required field.” In the bottom, right corner, click on the blue hyperlink “All
Properties.”

United States Department of the Interior

OFFICE OF THE SECRETARY
Washington, DC 20240

Date Signed
Field Name:
. ) . " | Date Signed
OC IO D]Iel.t]ve ‘020-003 Required field All Properties

To: Assistant Secretaries
Heads of Bureaus and Offices



9. In the Text Field Properties dialog box, click on the General Tab and in the Tooltip Field,
add “Click to Date Stamp.”

General Appearance Position Options Actions Format Validate Calculate

Name: |Date Signed

Tooltip: |C|ick to Date Stamp

Commeon Properties

Form Field: | Visible ~ [JRead Only

Orientation: | 0 ~ | degrees [/ Required

[ Locked sz

10. Click on the Appearance Tab and ensure the text font and font size matches your
document.

a. Note: Most DOI documents will be in Times New Roman and 12-point.

General Appearance Position Options Actions Format Validate Calculate

Borders and Colors

Border Color:  |[&] Line Thickness: | Thin

Fill Color: | Line Style: | Solid
Text
Font Size: |12 v Text Color: ||l
Font: | Times Mew Roman -
[JLecked Close



11. Click on the Position Tab and ensure the Position Width is 2 inches and the Position
Height is 0.25 inches. Click the box “Do not change height and width when changing the
position.” This grays out the Width and Height fields. You may click and drag the box
to center it under the Office of the Secretary, Washington, DC 20240 on the electronic
letterhead, as necessary.

General Appearance Position Qptions Actions Format Validate Calculate

Units: | Inches v

Position

Left: |3.1in ~  Bottorm: [9.29in =
Right: [5.1in = Top: [9.34in =
Width: |2 in Z  Height |0.25in =

Do not change height and width when changing the position.

[ lLocked Close

12. Click on the Options Tab and change the Alignment Field to “Center” by clicking on the
drop-down menu arrow.

General Appearance Position Options Actions Format Validate Calculate

Alignment: | Center

Default Value:

Field is used for file selection
Password

Check spelling
Multi-line

Scroll long tesxt

Allow Rich Text Formatting

[ Limit of 0 characters
Comb of 0 characters

[JLocked ez



13. Click on the Format Tab and scroll down to highlight “mmm d, yyyy”. Your date will
appear in the “Example of current format:” field. Click Close.

General Appearance Position Options Actions Format Validate Calculate

Select format category: | Date ~

MMm-yyyy A
FMMm-yy

MMMm-yyyy

mmm d, yyyy

mmmm d, yyyy

mydfyy MM t

Example of current format: May &, 2020

14. Close the Prepare Form Tool by clicking Close in the upper-right corner. Your date field
appears as a light blue box. Hover your cursor in the blue date field box and the Tooltip
appears, “Click to date stamp.” Again, you may click and drag to adjust placement of the
field, as necessary.

United States Department of the Interior

OFFICE OF THE SECRETARY
Washington, DC 20240

Click to Date Stam
OCIO Directive 2020-003

15. If you are date stamping the document, please continue to Steps 16 and 17. Otherwise,
you are done creating the Date Stamp field. Proceed to “How to Add a Signature Field to
a PDF”.



16. Click in the date field and a drop-down menu arrow appears. Click on the drop-down
arrow for a calendar to choose your date.

United States Department of the Interior

OFFICE OF THE SECRETARY
Washington, DC 20240

4 May 2020 4
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] Today: 5/6/2020

17. Congratulations! You have date stamped your document. Now, proceed to adding a
digital signature field to your PDF file.

Digital Signature Field

1. On the Prepare Form ribbon over the top of the document, click the icon for Add a digital
signature field.

m T B2 &

2 m@m | # ©

Add a digital signature; add signature options from the
Properties view

2. Your mouse will turn into a light blue box for you to Left mouse click > Drag a box >
Release. (This is where you want the digital signature in your file).

3. Release the signature field box so the bottom of the box aligns with the bottom of the
“From: [Name] text line. You will standardize the placement and size of box you create
in Step 7.

Aggistant Secretaries
Heads of Bureaus and Offices

Full Name of Signatory Official
Office of the Chief Information Officer

Digital Signature Policy



4. Within the Field Name properties box, enter “[Person’s Name] Signature” and check the
box next to: “Required field.” Click on the “All Properties” blue hyperlink.

John Doe Sic

Df Field Name:

| John Doe Signature

All Properties

5. In the Digital Signature Properties, dialog box, click on the General Tab enter “Click to
sign, check box to lock document” in the Tooltip field.

Digital Signature Properties x

General Appearance Position Actions Signed

Name: |Jnhn Doe Signature

_ Tooltip: |CI|cktD sign; check box to lock document]

Commaon Properties

Form Field: | Visible ~ [JRead Only

| Orientation: | 0 ~ | degrees [A Required

[ Locked Close

6. Click on the Appearance Tab, leave the font size default to Auto. The font defaults to
Helvitica. You can scroll down to change the font to Times New Roman.

Digital Signature Properties ]

General Appearance Position Actions Signed

Borders and Colors

Border Color:  fM%4 LineThickness: | Thin

Fill Color: [ Line Style: | Saolid
Text
Font Size: | Auto Text Color: |
Font: | Times MNew Roman w
[JLocked Close



7. Ifyou just added the Date Field, Adobe remembers... Uncheck the box “Do not change
height and width when changing the position.” On the Position Tab ensure the Position
Width is 3 inches and the Position Height is 0.40 inches. Recheck the box “Do not
change height and width when changing the position.” This grays out the Width and
Height fields. Click Close.

Digital Signature Properties %

General Appearance Position  Actions  Signed

Units: | Inches w
Position
Left: ’W % Bottom: IW =
Right: ’W = Top: IW =
Width: |3 in 2 Height: [04in =

Do not change height and width when changing the pesition.

[JLocked Tt
a. NOTE: If you have more than one signature in your file (e.g., a “Through” line), you
must give each digital signature field a unique name. Repeat Steps 5-11 for each

signature required. Click Close after adding each signature field.

8. Close the Prepare Form Tool by clicking Close in the upper-right corner. Your signature
field appears as a light blue box with the red “Sign here” flag. Hover your cursor in the
blue date field box and the Tool Tip appears, “Click to sign, check box to lock document
(Click to sign)”. Again, you may click and drag to adjust placement of the field, as
necessary.

1 Offices
ry Official r

]forlnarion Ofﬂcer |Click to sign; check box to lock document (Click to 5igr1)|

9. Congratulations! You have added a digital signature field.

10. Save your document, adjusting the file name by adding “ready for signature”. This
assists with version control.



Run the Accessibility Checker

1. To check the accessibility of your document, click on the Accessibility Tool Menu, select

Full Check.
() Full Check
® ACS Accessibility Full Check]

ty Fu ec xl
G, Identify Form Fields L
Set Alternate Text
';\ Setup Assistant O
E Reading Order @

2. Click Start Checking.

Report Options
Create accessibility report Folder: C:\Users\Ibigge\Decuments Choose..,

[] Attach report to document

Page Range
(®) All pages in document (O Pages from 1 to |1

Checking Options (31 of 32 in all categories)

Category: | Document o

[«] Accessibility permission flag is set

] Document is not image-only PDF

[+] Document is tagged PDF

Document structure provides a logical reading order
[] Text language is specified

Document title is showing in title bar

Bookmarks are present in large documents

Document has appropriate color contrast

Select All Clear All

Show this dialog when the Checker starts

Help Start Checking Cancel



3. The Accessibility Checker Menu appears on the left side of the document.

‘ Home Tools Training_OCIO Dire... X
w B XN Q @™ @® 12 Y

I Accessibility

[D Accessibility Checker X

0 &=~ Unitec
5 Document (3 issues)

@ > Page Content (1 issue)

@ b Forms (1 issue)
> Alternate Text

B 5 Tables OCIO Direetive 2020-003

% > st To: Assistant Secret:

% > Headings Heads of Bureav

From: Full Name of Si

>

You must address all issues marked with a question mark @ and red “X” ﬁ

4. Open all the arrows next to headings in bold, which indicates accessibility issues.

~ Document (3 issues) o]

o Accessibility permission flag - Passed
a# Image-only PDF - Passed
«# Tagged PDF - Passed
@ Logical Reading Order - Needs manual check
«# Primary language - Passed
) Title - Failed
«# Bookmarks - Passed
{@ Color contrast - Needs manual check
~ Page Content (1 issue)

o Tagged content - Passed

~ ) Tagged annotations - Failed

Element 1
4 Tab order - Passed
o Character enceding - Passed
«# Tagged multimedia - Passed
o Screen flicker - Passed
w# Scripts - Passed
o Timed responses - Passed
«# Mavigation links - Passed
~ Forms (1 issue)
~ @ Tagged form fields - Failed

Field 1
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5. To correct the “Title Failed”, right click on it and click Fix
@ Logical Reading Order - Needs manual check

g Primary language - Passed

w# Bookma Fix
@ Color co &klp Rule

e Page Cont B

o Tagged ¢ Check Again

6. In the Description Window, uncheck “Leave As Is” and enter the document Title. You
can repeat for Subject, Author and Keywords if you wish. Click OK.

Description
L=l
Title: IOCIO Directive 2020-003

BV L

[Jleave Asls
0 =
i~

Subject: IDigitaI Signature Policy

114

[JLeave As s
N Author: I €
1
L4 Leave As s X
el

Keywords: I

1 Leave As |s W
= § T

7. The Title Failed changes to Title Passed.
% LTI R CTEN Y

s Title - Passed

® ag# Bookmarks - Passed
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8. To correct the Tagged annotations — Failed, click on the Tag panel, highlight the main
“Tags” at the top, right-click and select Find

I Accessibility
@ Tags X
@ 2 E, New Tag...
(E} b Delete Tag
> Delete Empty Tags
2 Reading Order (x)
B ?
o) Find...
?
5|  Edit Class Map..
3 Edit Role Map...
> Tag Annotations
? | « Document is Tagged PDF
? .
v Apply Role Mapping to Tags
? | « Highlight Content
? Properties...
20

9. In the Find Element dialog box, click on the dropdown menu, select “Unmarked
Annotations,” then select the radio button next to Search Document, and click “Find.”

Find Element n

Find: |Artifacts e
1 Artifacts ‘
Unmarked Comments
1 Unmarked Links

Type: ‘Unmarked Annotations
{ Unmarked Content

€ OCR Suspects
‘ Find . Tag Element Close
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10. The date field you added is highlighted. Click “Tag Element,” select “Form” in the

11.

12.

“Type” field, and click OK. The next, if any, unmarked annotated field is automatically
highlighted. As you can see, the digital signature field you added is now highlighted.
The Find Element dialog box remains open until you close it; therefore, click “Tag
Element” and “Form” should already be selected, then click OK. The Find Complete
dialog box opens. Click OK and click Close in the Find Element dialog box.

formation Officers
Find: | Unmarked Annotations ~ )Iﬁcers

il
Type: John Doe Signature i

() Search Page (®) Search Document

e PSP Tag Hement _actor Authentication (AMFA)
New Tag *
d Offic| wpe [Arice [v] en Officers
d Offic ] Article ~
Title: Annotation
T Bibliography Entry
2 of Slg Block Quote
he Chiérmmx 2ption -
Code
Division
tation of Alte|Document Authentication (AMFA)
Figure I

& Find Completed

OK

Rerun the Accessibility Checker by selecting “Full Check” and clicking “Start
Checking.” Three manual checks should be displayed: Logical Reading Order — Needs
manual check, Color contrast — Needs manual check, and Navigation links — Needs
manual check. The logical reading order and color contrast will be in the Document
heading and Navigation links will be in the Page heading. Click Close to close the
Accessibility tool. Click the “X” in the upper-right corner of the Accessibility Checker to
close the report.

Save the file and continue to the “Fixing Reading Order for the Date and Digital
Signature Fields” to finalize the PDF file for digital signature.
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Fixing Reading Order for Date and Digital Signature Fields

1. Open the reading order panel on the left pane. If you do not see this icon on the left pane,
right-click and select the icon. It will be added as a shortcut to the left pane. Navigate to
the “Options” menu in the upper-left corner of the Order panel (it the icon to the left of
the “1” in a circle) and select “Show reading order panel.”

@ Order X

] Show reading order panel _
T
Q Show page content groups ’

Display like elements in a single box
v Show table cells

@
[ | |« shontipessndngirss
=1
©

2. The Reading Order panel opens. Make sure the box next to: “Display like elements in a
single block™ is unchecked.

Draw a rectangle around the content then click oneof g
the buttons below:

Figure
Form Field Figure/Caption
Heading 1 Heading 4 Table
Heading 2 Heading 5 Cell
Heading 3

Reference (g) Nate (z)
Table Editor

[ Show page content groups | |
(®) Page content order
() Structure types

[] Show table cells ]

— [] Display like elements in a single block

[ Show tables and figures ]

Clear Page Structure... Show Order Panel

Help Close

14



3. You will notice tagged items in the PDF file are displayed in grey blocks with a
corresponding number in the upper-left corner to the number listed in the Order panel.
The date and digital signature fields are at the bottom of the order for Page 1. In this
example, they are numbers 29 and 30. The fields need to be moved so a user using
assistive technology has the date field read after the letterhead and the digital signature
field read after the full name of the signatory official. To move the date field, you will
hold your left mouse button and drag it above the word, “Memorandum” and release your
left mouse button.

@ Order X
q E-O

= 5]
E = [6] Memorandum

& 7]

= | [8] To: Bureau and Office Associate Chief Information

@ ©

= [9] Bureau and Office Hurman Resource Officers

g [10]
= | [11] From: Full Name of Signatory Official

< ™

= [12] Office of the Chief Information Officer

& 031

w [14] Subject: Implementation of Alternative Multi-Fact
=] [15] Path

= [16] This memerandum promotes and authorizes the |
= | [17] Temporary Procedures for Onboarding and Other
= | [18] process, who otherwise cannot be issued a Depar
= [19] Path

= [20] Perthe Office of Management and Budget (OMB)
& 1211

= | [22] During the coronavirus disease 2019 (COVID-19) P
= [23] Temporary Procedures for Onboarding and Other
= [24] ; however, personnel onboarded using these proc
& 1251

= [26] The Office of the Chief Information Officer (OCIO
= [27] Path

= | [28] The OCIQ, in cooperation with bureau and office
= 091 DoteSgned

5 1301 John Doe Signature

L SN B | '™
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4. Repeat the same steps for moving the digital signature before the signatory official’s title.

Order X
Lk

BE-®

e | L] LML PRI

= [7] Memorandum

g (8]

= [9] To: Bureau and Office Associate Chief Information
=1 [10] Bureau and Office Human Resource Officers

g (1]
= [12] From: Full Name of Signatory Official

Mmoo & O

= [13] Office of the Chief Information Officer

)

g (4]

= [15] Subject: Implementation of Alternative Multi-Fact
= [16] Path

= [17] This memorandum premotes and authorizes the i
= [18] Temporary Procedures for Onboarding and Other
= [19] process, who otherwise cannot be issued a Depar
= [20] Path

= [21] Per the Office of Management and Budget (OME]
& (2

= [23] During the coronavirus disease 2019 (COVID-19} P
= [24] Temporary Procedures for Onboarding and Other
= | [253] ; however, personnel cnboarded using these proc
& [20]

= [27] The Office of the Chief Information Officer (QCI0
= [28] Path

= [29] The OCIC, in cooperation with bureau and office.
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Close the Reading Order dialog box by clicking “Close,” then close the Order panel by
clicking the “X” in the upper-right corner.

Save your file. It is recommended to add “Ready for Signature” to your filename to
ensure version control and decipher the final PDF to send to the signatory official.

Congratulations! Your PDF file is ready for the signatory official’s digital signature. As
a reminder, the signatory official will select the date she or he is signing the PDF file
first, then click on the digital signature field to digitally sign and click “Lock document
after signing.”
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